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Using this manual
Each page in this manual follows a general layout of 
three columns. Read left, to right, to the bottom of 
each column, then move to the next.

Important keywords are bolded, values are 
highlighted in red. On images, areas of interest 
are highlighted with red arrows or squares/circles. 
External links will precede a ↗.

Table of contents
The table of contents can be found on the next 
page. Chapter titles and sections are hyperlinked. 
You can click on a chapter title or a section to 
quickly navigate. You can click on the video ↗ 
button to watch the video for that chapter. 

Chapter cards
Clicking on chapter titles along the bottom bar will 
also take you to its chapter card. The section titles 
are hyperlinked, and to the right, corresponding 
timestamps are hyperlinked for the accompanying 
video for that chapter.

This manual was last updated on 
March 5, 2022 1:42 AM

Using this manual

You can see the section you 
are currently in.

Click here to go to the table of 
contents.

Click on a chapter to quickly go to its title card.
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Quick Links:

1. Power & Speed Chart
2. Video Tutorials Playlist ↗
3. Nesting Tutorial Video ↗

https://youtu.be/s0cSeWaGyoY
https://www.youtube.com/watch?v=GPOdFujDCEI
https://www.youtube.com/playlist?list=PLWOl5M5R7FKkqZ3Z5bEJrN8OzbpCSkYJe
https://www.youtube.com/watch?v=BPk20JRmFKg&list=PLWOl5M5R7FKkqZ3Z5bEJrN8OzbpCSkYJe&index=2
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Basics					     4
Rhino					     5
AutoCAD				    7
Nesting				    8

Skip to 0:12 ↗
Skip to 0:55 ↗
-
video ↗

Setting Up video ↗

https://www.youtube.com/watch?v=s0cSeWaGyoY&t=12s
https://www.youtube.com/watch?v=s0cSeWaGyoY&t=55s
https://youtu.be/BPk20JRmFKg
https://youtu.be/s0cSeWaGyoY
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Hours of Operation
 
Monday - Friday: 10 am to 10 pm.  
For weekend hours, refer to the website ↗.

Pricing
Laser cutting costs 33 cents per minute ($20/hour). 
Allowable daily cutting time changes based on 
demand. It can range from 1 hour to 3.5 hours.

Materials
The Daniels wood shop sells various materials  
pre-cut to laser bed size, the price and materials 
list is located on the website under the laser 
cutting page ↗

Refer to the Power & Speeds chart to see what you 
can cut on the laser cutters safely.

WARNING:
DO NOT cut or engrave glass, metal, 
foamcore, MDF, or polycarbonate. 
Inappropriate materials may produce 
harmful fumes. If in doubt, ask the  
Fabrication Technologist/Coordinator.

Booking Your Test
Everyone who uses the laser cutter must pass the 
mandatory test. If you passed last year, please read 
over this manual before using the laser cutters.

The mandatory tutorial/test is offered regularly. 
Head to training.daniels.utoronto.ca ↗ to sign up 
for a session. 

You must first login, then select one of the sessions 
and sign up. Please read this manual before signing 
up for a session.

Basics

Basics

https://www.daniels.utoronto.ca/info/current-students/resources/laser-cutters
https://www.daniels.utoronto.ca/info/current-students/resources/material-resources-suppliers
https://www.daniels.utoronto.ca/info/current-students/resources/material-resources-suppliers
http://training.daniels.utoronto.ca
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Create References
	
Once your cut geometry is ready, create the laser cutter bed reference (larger rectangle) which can be 
either 32” x 18” (812 mm x 457 mm) for the smaller laser cutters, or 48” x 24” (1219 mm x 609 mm) for the larger 
laser cutter. Then create your material reference, which should be smaller than the laser cutter bed.  
 
The laser cutter origin is located in the top left corner. Place your geometry inside your material reference - 
ideally in the corner so you can reuse the rest of your material.

In this example, we will be cutting the square, scoring the triangle, and engraving the filled circle.

Rhino Setup Layers
Layers will allow you to easily separate power & 
speed settings for your curves inside Rhino.

You can add up to 8 layers for 8 different power & 
speed settings, but most projects tend use just 
1 or 2. In general, one layer will be for cutting, and 
one or more layers will be for different amounts of 
scoring/hatching. 

Create and name layers according to what you 
intend to do with the laser cutter. The “cut” layer 
will be for cutting, “score” will be for scoring lightly 
without cutting through the material, and “engrave” 
will be for engraving a solid fill.

Once layers have been created, the Color, Linetype, 
and Print Width of each layer must be set as shown 
on the next page.
 

Rhino

1 2 3

Laser cutter bed reference

Material reference
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Set Layer Color

Double-click on the Color beside the layer name 
to select the layer color. Each layer must have a 
unique color from the following list of 8 colors: 
Black (0,0,0), Red (255,0,0), Green (0,255,0), Yellow 
(255,255,0), Blue (0,0,255), Magenta (255,0,255), Cyan 
(0,255,255), Orange (255,127,0).

Pick the colors from the list on the left. The laser 
cutter software will only recognize the colors from 
the above list.

Set Layer Linetype

Double-click on the Linetype beside each layer and 
set them all to “Continuous”.

Set Layer Print Width

Double-click on the Print Width beside each layer 
and set them all to “Hairline”.

Assign Curves to Layers
Assign the curves to the layers you have created. 
Your curves should display the layer color in the 
viewport. In this example, they are red (cutting), 
blue (scoring), and green (solid fill).

First, ensure your curves are on the Rhino XY 
Plane. Select your cutting geometry, and enter 
“ProjectToCPlane” as a Rhino command. Choose 
“yes” when it asks to delete original input geometry.

Then, make sure there are no duplicate curves in 
your file. Deselect everything and enter “SelDup”. If 
any duplicate curves were selected, simply delete 
them.

Save and close your Rhino file.

You are now ready to add yourself to the laser 
cutting queue. Refer to Signing Up for the Queue 
for instructions.

Rhino
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AutoCAD

AutoCAD

Create References

First, draw the laser cutter bed, and your material 
reference. The laser cutter origin is located in the 
top left corner. Bed sizes that can be used:

Small laser cutter (PLS 6.150D): 
32” x 18” or 812 mm x 457 mm
Large laser cutter (ILS 12.150D):  
48” x 24” or 1219 mm x 609 mm

Set Color & Lineweights
These settings can be changed from the 
Properties section of the Home tab in AutoCAD.

Set Color

Then, set colors to differentiate cut power & speed. 
Use the true RGB colors: Black (0,0,0), Red (255,0,0), 
Green (0,255,0), Yellow (255,255,0), Blue (0,0,255), 
Magenta (255,0,255), Cyan (0,255,255), Orange 
(255,127,0).

Set Lineweights

Select all cut geometry, then from the Lineweight 
drop-down, choose “0.00 mm”.

Save and close your AutoCAD file.

You are now ready to add yourself to the laser 
cutting queue. Refer to Signing Up for the Queue 
for instructions.
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Nesting

Nesting

Watch the video tutorial ↗

Nesting will reduce material waste and save you 
money by making the most out of a sheet of 
material. 

It is especially useful when cutting multiple 
geometries generated via Grasshopper, as it can 
number your pieces too.

You can do this automatically using OpenNest - a 
free plugin for Grasshopper, but it can be done 
manually in any program.

Installing OpenNest
The following instructions will only apply to  
Rhino 6 & 7.

Head to www.food4rhino.com/en/app/opennest ↗

Scroll to the download section, click “Install”. If 
you do not see this option, first log in using your 
Rhino account. Click “Open Rhino 7” on the pop-up 
prompt that appears immediately afterwards.

The package manager will open inside Rhino 7.

Click “Install”, then “OK”, and then restart Rhino.

Using OpenNest
OpenNest runs inside Grasshopper.
Search for “OpenNest” to bring in this component.

OpenNest requires “Sheets” which will be your 
material boundary and “Geo” which will be your 
geometry to nest. The “Spacing” input is optional, 
but should be increased from the default in order 
to account for laser kerf.

Assign Sheets & Geometry

First, reference your material boundary curve from 
Rhino using the Curve component in Grasshopper. 

Next, connect your curve geometry to the “Geo” 
input. The input must be flattened.

https://www.youtube.com/watch?v=BPk20JRmFKg&list=PLWOl5M5R7FKkqZ3Z5bEJrN8OzbpCSkYJe&index=2
http://www.food4rhino.com/en/app/opennest
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Spacing

Connect a number slider to the “Spacing” input to 
change the gap between nested objects.

Note: The spacing is based on your Rhino units. In 
this example, the file is set to mm. If your units are 
in inches, your spacing amount would not be 4.00, 
but instead 0.16 for the same amount of spacing.

Below is an example of 1 mm spacing vs 4 mm 
spacing.

When your spacing is too low (less than 2 mm), the 
laser kerf may intersect with neighboring nested 
pieces. 

Numbering

Once OpenNest has nested your geometry, it may 
be difficult to tell which floor plates are which as 
OpenNest dynamically positions and rotates the 
pieces.

In order to identify floor plates after they are 
nested, you can use the Text component from 
OpenNest.

This text component generates curves that are 
designed to be laser cut quickly. 

It requires the Location to place the text, and the 
Text itself. Optionally, you can change the Size and 
Font.

We can use the Area component to get the center-
point of our nested curves, to connect to Location.

For text, we can use the ID output from OpenNest, 
to connect directly to the Text.

Baking

Once you have successfully nested and numbered 
your geometry, it is time to bake them to the 
appropriate layers.

For example, the “Geo” output from OpenNest 
would go to the “Cut” layer, and the Curves from the 
Text component would go to the “Score” layer.

Refer to page 5.

Nesting
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The Laser Cutters			   11
Starting Up				    13
Setting Z-height			   13
Sending Your File to the Laser Cutter	 14
Power & Speed				   19
Universal Control Panel (UCP)		  22
Finishing Up				    24
Troubleshooting			   25
Asking for Assistance			   25

-
Skip to 0:17 ↗
Skip to 0:38 ↗
Skip to 1:30 ↗
Skip to 1:58 ↗
Skip to 4:26 ↗
Skip to 6:32 ↗
-
Skip to 7:20 ↗

Beginning to Cut video ↗

https://www.youtube.com/watch?v=GPOdFujDCEI&t=17s
https://www.youtube.com/watch?v=GPOdFujDCEI&t=38s
https://www.youtube.com/watch?v=GPOdFujDCEI&t=90s
https://www.youtube.com/watch?v=GPOdFujDCEI&t=118s
https://www.youtube.com/watch?v=GPOdFujDCEI&t=266s
https://www.youtube.com/watch?v=GPOdFujDCEI&t=392s
https://www.youtube.com/watch?v=GPOdFujDCEI&t=440s
https://www.youtube.com/watch?v=GPOdFujDCEI
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The Laser cutters

The Laser Cutters
The Laser Cutting Lab contains 5 PLS6.150D 
machines, and 1 ILS12.150D. The ILS12.150D has 
a larger bed, and a slightly more powerful laser 
compared to the blue PLS6.150D. 

PLS bed size: 32” x 18” (812 mm x 457 mm) 

ILS bed size: 48” x 24” (1219 mm x 609 mm) 

Laser cutter lid

Make sure to close this lid completely closed, 
otherwise the laser will not turn on. 

Opening the lid during operation will cancel the 
job. Pause first using the UCP, then open the lid if 
required.

Z-height setter

This tool is used to set the laser head height for 
optimal cutting. Refer to the next page.

Laser head

This is the cutter head that moves around to focus 
the laser beam on the part that you are cutting.

Avoid staring directly into the laser point.

Laser cutter lid

Laser head

Z-height setter	
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Laser cutter computer

This computer is where you will open your Rhino or 
AutoCAD file to send to the machine. Please do not 
make changes / work on your file on this computer. 
Only use this computer for setting up the laser 
cutting settings.

Exhaust pipe

The laser cutter produces toxic fumes during 
cutting. The smoke exhaust will leave through this 
pipe. You will hear the overhead ventilation system 
running loudly when one or more machines are 
turned on.

Compressed air in

Compressed air is required to cool the laser lens. 

The yellow lever should be parallel with the pipe.

Emergency cut-off

This panel controls all electricity and air to the 
machine. In case of a fire, pull this switch to shut off 
the machine.

Uncut material holder

When cutting multiple sheets of material, you can 
organize yourself by storing uncut material on the 
side.

Finished material storage

Place your cut sheets on this tray.

The Laser cutters

Exhaust pipe
Emergency cut-off

Compressed air in

Laser cutter computer Uncut 
material 
holder

Finished material 
storage
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Starting Up
Once inside the room, use the kiosk to select the 
laser cutter you were assigned, then tap your key 
fob on the reader to turn it on. The laser cutter will 
take around 1 minute to turn on.

Setting Z-height
Once the laser cutter has turned on, you will see 
the following screen on the laser cutter display.

Navigate to “Z” using the buttons beside the 
screen.

On this screen, use the up and down buttons to 
raise or lower the laser cutter bed.

The left and arrow keys can be used to choose the 
adjustment step size, i.e. 0.100, 0.010, or 0.001 in. The 
check-mark under the digit is the current step size.

Starting Up / Setting Z-height 

Using the z-height setter placed on top of your 
material, and beneath the laser head, use the up 
and down buttons to set the correct z-height.

An incorrect z-height may cause fires, or cause the 
laser to not cut through your material.

Once you have set the z-height, close the laser 
cutter lid.

NoYes
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Sending Your File to 
the Laser Cutter
Once the machine has been set up, open your 
Rhino/AutoCAD file on the laser cutter computer. 

Rhino
From the Rhino Top view-port, enter “Print” as a 
Rhino command. 

The Rhino Print Setup dialog will open.

Destination & View and Output Scale are the two 
main tabs you need to pay attention to. In most 
cases, you will need to set the power & speeds 
using Properties, and set your window using “Set...”

The next few pages will go over how each of these 
tabs should be set up, so that if you face any issues 
during printing, you will have something to refer to.

Sending Your File to the Laser cutter
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Rhino ctd.

Destination

Select “PLS6.150D” from the print driver drop-
down. Set Size to “User-Defined LANDSCAPE”. 
Ensure page orientation is set to “Landscape”.

Set the Output Type to “Vector Output”, and Output 
Color to “Print Color”.

IMPORTANT:
Click Properties to open the Power & Speeds 
window. Refer to page 22. 

View and Output Scale

Ensure the “Top” viewport is selected.
Select “Window”, then set the window to the laser 
cutter bed reference rectangle using “Set...”.

Your scale should be 1:1. Always scale your cut 
geometry prior to cutting. Scaling afterwards in 
the Universal Control Panel (UCP) may not yield 
desirable results.

1
2

6
3

4

5

7

8

9

Sending Your File to the Laser cutter
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Rhino ctd.

Margins and Position

The margins should all be set to 0. 

Linetypes and Line Widths

Under Linetype, choose “Match pattern definition”.
Under Line Width, set “Scale by” to “1.0”, and 
Default line width to “Hairline”.

The remaining settings can be set as shown.

1

2

Sending Your File to the Laser cutter
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Rhino ctd.

Visibility

Everything except Locked Objects should be  
un-checked.

Printer Details

In this section, verify Scale is set to 1.0 for X, Y 
and that the printable area is correct for the laser 
cutter you have selected.

If every tab is set up correctly, and you have verified 
your print preview on the right, click Print to send 
your file to the UCP (Laser cutter software).

1

2

3

4

Sending Your File to the Laser cutter
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AutoCAD
Once you have logged onto the laser cutter 
computer during your scheduled cut time, begin by 
opening your file in AutoCAD.

Enter “Plot” into the command bar to open the Plot 
window.

Choose “PLS6.15D” from the plotter name drop-
down menu. When prompted, choose the first 
option:

From the “What to plot” drop-down, choose 
“window”, and draw a window from one corner of 
the bed rectangle to the other. 

Plot offset should be “0” for both x, y. 

Scale should be “1:1”.

Set Drawing orientation to “Landscape”.

Ensure plot style 
table is set to “None”.

Click “Properties” 
beside the plotter 
name drop-down, 
then on the next 
window, click 
“Custom Properties” 
to access the Power 
& Speeds menu. 

Refer to Power & 
Speed Settings.

Click “OK” once you 
have set everything 
up to send your file to 
the laser cutter.

1

3

2

5

6

7

8

9

10

11

4

Sending Your File to the Laser cutter
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Power & Speed
Cutting/Scoring
Clicking on the printer properties button will bring 
up this screen. Select each color used in your 
project individually, and set the power and speed 
percentages. These values change for different 
materials and thicknesses. Refer to the Power & 
Speeds chart for your chosen machine, material, 
and thickness.

Set Laser to “Both” 
Mode to “Vect”
Z-Axis to “OFF”
Flow to “Air”
Flow Rate to “100%”

WARNING: 
You must set Flow to Air, and Flow Rate 
to 100% for every color, even those set to 
“Skip”.

Set PPI to 500. If you notice a jagged edge, this may 
be alleviated by increasing the PPI to 1000.

Click on the large circular Set button to save 
settings for each color. If you do not click Set,  your 
settings will revert to previous.

Repeat the above steps for the remaining chosen 
colors used in you project. Set every other color 
mode to “Skip”

Under the Vector tab, select “Enhance and Sort”, and set the Quality slider all the way to the left. Ensure the 
scaling values are set accordingly. If you modeled 1:1, set both X and Y to 1.0000.

Once the power and speed values have been set up, click “OK”. 

The above window will close, and the previous Print Setup (Rhino) or Plot (AutoCAD) window will be back 
in focus. If all other settings have been setup as shown in the previous page, click “Print” (Rhino) or “OK” 
(AutoCAD) to send your file to the Universal Control Panel (UCP).

Power & Speed
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Engraving Solid Fills	
These additional instructions are to be followed 
only if you are engraving a solid fill.

Set Mode to “Rast” for the color you have set to 
solid hatch.

Set Speed to “100%”. 

The Power will depend on how light or dark you 
want to engrave. The scoring power values for your 
chosen material is a good starting point.

Under the Raster tab below, you can set the Image 
Density. A higher density will produce a more even 
fill, but will take longer. For most cases, you should 
set this value to 4 or 5.

Under Print Direction, set the direction to “up” to 
engrave from bottom to top. This will prevent the 
laser from cutting through smoke.

lower (1) higher (7)

Once everything has been set up, click “OK”. 

The above window will close, and the previous Print Setup (Rhino) or Plot (AutoCAD) window will be back 
in focus. If all other settings have been setup as shown in the previous page, click “Print” (Rhino) or “OK” 
(AutoCAD) to send your file to the Universal Control Panel (UCP).

Power & Speed
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1/32”  or  0.79 mm 1/16”  or  1.6 mm 3/32”  or  2.38 mm 1/8”  or  3.2 mm 1/4”  or  6.4 mm

Score Light Score Cut Score Light Score Cut Score Light Score Cut Score Light Score Cut Score Light Score Cut

Ac
ry

lic P 5%
S 10%

P 10%
S 10%

P 25%
S 10%

P 4%
S 10%

P 8%
S 10%

P 40%
S 5%

P 5%
S 10%

P 10%
S 10%

P 25% 
S 10%

P 25%
S 25%

P 25%
S 15%

P 50%
S 3%

P 50%
S 20%

P 30%
S 5%

P 100%
S 1%

A
ir

cr
af

t 
 

P
ly P 10%

S 15%
P 20%
S 15%

P 50%
S 8%

B
as

sw
oo

d

P 2%
S 15%

P 4%
S 15%

P 15%
S 15%

P 5%
S 15%

P 10%
S 15%

P 20%
S 10%

P 5%
S 15%

P 20%
S 15%

P 65% 
S 15%

P 25%
S 25%

P 25%
S 15%

P 40%
S 10%

P 25%
S 25%

P 25%
S 10%

P 40%
S 5%

P
ly

w
oo

d

P 5%
S 15%

P 10%
S 15%

P 25%
S 10%

P 10%
S 10%

P 25%
S 10%

P 35%
S 5%

P 5%
S 15%

P 10% 
S 15%

P 25% 
S 10%

P 25%
S 25%

P 25%
S 10%

P 40%
S 5%

C
ar

d
bo

ar
d

P 10%
S 10%

P 35%
S 25%

P 30%
S 10%

P 25%
S 25%

P 25%
S 10%

P 40%
S 20%

M
at

bo
ar

d

P 10%
S 15%

P 20%
S 15%

P 50%
S 15%

Ve
ne

er P 5%
S 20%

P 10%
S 20%

P 20%
S 20%

These settings are guidelines only.

Always test power and speed settings every time you lasercut. 

Power & Speed

Power & Speed
Chart
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Universal Control 
Panel (UCP)

Universal Control Panel (UCP)

File selector

Side bar

Runtime clock

This is the software that controls the laser cutter. 
When you print or plot your file to the laser cutter 
from either Rhino or AutoCAD, it will appear here.

You will find the UCP icon on the desktop, or pinned 
to the task-bar.

To Start the Cut
Assuming you have set up the laser cutter by 
following the instructions on page 13, you can press 
the green play button to start cutting.

The UI
This next section will cover some of the features 
and functions of UCP.

File selector

The files sent to the laser cutter will appear here. 
The last file is automatically selected.

Side bar

This bar has several useful buttons including the 
Start/Pause, jog, homing, time estimator, and other 
useful functions. 

The settings button in the side bar will bring up 
the Power & Speeds window where you can double 
check your power & speed settings, or make 
adjustments while the machine is paused.

Runtime clock

This counts how long you have been cutting for. 
This is not the clock that determines how much you 
are charged. You will be charged from the moment 
you tap your key fob until you tap out.

WARNING:
The laser cutters will stop immediately 
when your time runs out, or when the lab is 
closed at 10 PM.

Before you start cutting, use the time 
estimate tool shown on the next page.
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Sidebar Buttons

Start/Pause

The larger button will start the lasercut job from 
the beginning. The smaller button becomes active 
while cutting, and can be used to pause/resume 
the cut.

Manual Jog

These buttons can be used to manually move the 
laser head in small increments.

Homing Buttons

These buttons will home the machine. Do not home 
the z axis. Refer to page 13 to set the z-height.

Zoom

Left-click to zoom in, right-click to zoom out. Useful 
in inspecting fine areas of your geometry.

Focus

Click anywhere to move the laser head to that 
location. Useful for determining whether the laser 
will stay within uncut areas when cutting from a 
used sheet, or from smaller sheet.

Move

Click and drag your geometry as it appears in the 
preview window to move it somewhere else on 
the laser bed. Useful for creating test cuts on your 
material without having to print again.

If your sheet material is smaller than the laser bed, 
be wary of moving your cut geometry outside your 
material.

Duplicate

Create duplicates of your geometry in the x and/or 
y direction. Be wary of cutting outside your material 
boundary.

Time Estimate

Estimate the cutting time. Run this before a long 
cutting operation to determine if you have enough 
time to cut.

Universal Control Panel (UCP)
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Finishing Up
Removing Material from Bed
As a tip, use masking tape to tape over the cut 
pieces so they do not fall out as you are lifting out 
your sheet material.

Always clean up after laser cutting, remove all 
materials from the laser cutter and take any USB 
drives you plugged into the computer.

Checking Out
Once you have finished cutting, removed your 
material, and cleaned your laser cutter, make sure 
to select your laser cutter on the kiosk and tap your 
key fob to sign out. 

You will be charged for the time you check-in to the 
time you check-out. If you forget to sign out, your 
will be charged for the maximum time for the day.

Please leave the room with all the materials you 
came in with.

Disposing of Scrap Material
If you are finished with your lasercut project and there is still usable space in your sheet material, consider 
donating it to the freecylcing area in the undergraduate studio (middle of studio).

If there is no usable space on the sheet, or if you need to dispose of small pieces, you can do so in the brown 
bin marked for “Plastics/Acrylic” or “Wood” in the west side of the building, past the doors to the recycling 
area.

Finishing Up
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Troubleshooting
1. Print Preview Incorrect

Check your scaling, page orientation, x/y offset, and color settings. Ensure the print window is set up 
correctly. Refer to page 14 for Rhino, page 18 for AutoCAD

2. Not Cutting Through or Burning

Check your Power & Speed settings. Check the z-height to ensure focus is set correctly. Ensure Flow is set 
to “Air”, and Flow Rate is set to “100%” in UCP. Refer to page 19.

If the problem persists, stop immediately and contact Nicholas (during day) or on-duty laser work-study 
(after hours).

3. Cutting Odd or Extra Shapes, or Going Back Over the Same Lines

Check for duplicate curves. Enter “SelDup”, then delete duplicate curves in Rhino. If no duplicate curves 
automatically selected, zoom in to verify.

4. Power & Speed Settings Read as “0” o Display. Raster / Pen Data is Empty Error

Lineweights not set correctly. Refer to page 6 for Rhino, page 7 for AutoCAD.

Troubleshooting

Asking for Assistance
If you have any questions or concerns, visit the 
Digital Fabrication office in room 167. 

Alternatively, use the video doorbell to reach out to 
the Digital Fabrication office from inside the Laser 
Cutting Lab.
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